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First of all, we would like to introduce ourselves:

KimeraMusical.com is a project born with the idea of providing to all those with musical
talent a professional musical production job at a price that everyone can afford.

You can decide how much you will pay for our work!

Pay What You Wantl!!

This is probably the best offer you have ever seen!

We are the first music production studio in the world where you pay for our work what
you think it is worth.

Our aim is make music production as accessible as possible to you, therefore, we offer
you the posibility to make us an offer, we trust you, choose our fee.

We are so confident that you will love our work, that we will only charge you what you
think wedeserve, and moreover, if you are not satisfied, we will you a full refund. The
future of this project s based on the trust we place in you and we know you will treat us
fairly.

What can made your songs have a final push and
allow you to make a living with music?

t's not a secret, moreover, it's the same method as 90% of the bands you thar you are
currently following or listening, and it's no other than looking for someone totally outside
the band, with experience and professionalism, who understands what you wanted to
express with my music and maximize it.

The musicians have inclinafion to blind ourselves with our art, thinking our work is perfect
and untouchable, making follies that many fimes can ruin our songs.

That's why someone outside the band is needed, someone who understands your music,
style, the musical concept you are trying to find, the purpose of yourwork, your sound,
etc..., enhancing your strengths, correct your defects, and achieves the perfect sound
and climate for your music.

This figure, is us.

Starting from your ideas and the approach of your song and your musical style, we
propose you the necessary changes fo maximize what you want 1o express and make it
reach a wider audience.

We present you some of our works so that you can notice how our producers work and
get an idea of what we can do for you.
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RECORDING A BEAT WITH MPC BEATS

STARTING A NEW PROJECT

To start a new project from scratch, in the first screen when starting the program, in the
"PROJECT TEMPLATES" section, choose "Empty" to start with an empty project.

D PROJECT TEMPLATES
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Empty Project Load Project

The first adjustment we will make to the project will be to set the number of quarter notes
per minute (BPM). This can be found in the central transport bar at the top of the screen.
By default it is 120. We can adjust it fo the desired tempo.

We go to the sequence information and rename it by & MIDI

typing the name we want to identify it (double click on the v

name to edit it) and set the bars we want for the current MyNewSequenceTl
sequence, for example 4 Bars (make sure you have the 4

loop mode activated to be able to work the rhythms in -

loop). -
1 (unused)

Program 001

CREATING A NEW TRACK
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To create a new frack, simply hover over the current
frack and click on the little arrow to the right of the ~

name. It will be enough to select the last track with 1 TheBeat

name "(unused)". 1 TheBeat vy

Once selected, by double clicking on the name,
you can type the desired frack name.

Once created, we could choose between the type
of track that will be: Drum, Keygroup, Plugin, MIDI,
Clip or CV. We leave it in the first option. Drum

ASSIGNING A PROGRAM TO A TRACK

Once the track is created, we have to decide what kind of program we want to link
(sound kit, drum samples).

To do this, we make sure that in the lower
right corner, we have selected the m

expansion viewer.

This will show on the right side, the expansions that we have MBEC BEATS
installed where we can choose a sound kit (program) to our il
liking.

We can navigate between the different expansions and
between the different programs until we find a sound kit to our
liking. We can hear an example of the sounds of the selected
kit if we press the play button at the bottom left of this area.

Once you have decided on a kit of
your choice, if you double click on it,
it will automatically load and be
selected in the "PROGRAM" section of
the track inspector.

HipHop-Kit-Gang Rich Kit
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If selected, the sounds will be automatically loaded and the entire lower part of the
screen will be updated. If we touch the pads, we will be able to hear the sounds of the
selected program.

Q-LINK MODE:  Screen i A PAD PERFORM PROJECT

All Samples .
v

NOTEREPEAT MALFLEVEL  1LEVEL ERASE

LOGP END
Bar Bar:2 GRIchSynS| GRichSyn2|  GRhSm3|  GRIchSnd

ENCE  SEQUENCELOOP  SEQUENCE
IGTH START

ang Rich Kit

Sequence 01
CURRENT TRACK TRACKLENGTH TRACKVELocy . TRACK
- B R TRANSPOSE
RACK: SEQ 00 off

; TIME CORRECT
TIMECORRECT  TIME DIVISION swinG i

HORIZONTAL
PLAYHEAD EErali)

=

RECORDING A BEAT

Once we have selected a track, and assigned a program to if, we only have to record.

If we want our beats to match the tempo without el screen
drift, we can adjust the following items from the Q-
LINK panel.

SEQUENCE SEQUENCE SEQUENCE LOOP SEQUENCE
LEMGTH START LOGF END
If you want your beats to sound without time drift, 90.0 bpm 4 Bar: 1 Bar: 4

activate the quantizer (time correct). This will
ensure that when you record, the notes you play TRk
are exactly in tempo. sEQ 100 off

TRACK LENGTH TRACK VELOCITY

Also set the fime division to 1/16 in the panel fo
provide enough bars. This means that one bar will
be divided into 16 parts, each of which can play
one note.

TIME CORRECT
STRENGTH

ON 1116 a0 100

TIME CORRECT  TIME DIVISION SWING

HORIZONTAL HORIZONTAL
SCROLL Z0oM

We can also activate or deactivate the 0.00dB 2%
metronome from the cenftral fransport bar.

PROGRAM LEVEL PLAYHEAD

SEQ

- To start recording we first activate the rec button on the central transport bar. This

will cause both the rec buftton and the play button to start flashing. We must be
careful, because if we have already recorded something in this tfrack, and we press the
rec button again, it will erase the previously recorded.

ﬂ If we want to record, but keep what has already been recorded in the track, we
will use the overdub button instead of the rec button.
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When we are ready to start recording, we press the play button. First we will hear
the metronome during the first bar so that we can get the tempo and then the
recording starts.

We can now start tapping our pads.

Once the bars of the track are finished, if we have selected the loop option mentioned
above, it will start again from the beginning, and so on and so forth, so that we can add
sounds wherever we want on each pass.

n Once we have finished our recording, we can press the stop button.

HOW TO RECORD A MELODY WITH ONE OF THE PROGRAM SOUNDS

If you notice, it is difficult to make a melody with the sounds that the kit of the selected
program gives us. If for example we want to create a bass line or we like a pad or a vocal
sound, but there is only one sound in the whole kit, it will be impossible to make a melody,
since we would have the same tone all the fime.

In order to make a melody from one of the sounds in the kit or a bass line, you have to
do the following:

Select the sound with which you are going
fo create your melody or bass line, and

press the "16 LEVEL" button.
HOTE REPEAT  HALF LEVEL m

In the screen that appears, we simply have
to make sure that the type is "Tune". This will
distribute the sound chromatically among
the different pads.

GRich Syn 5 GRich Syn 2 GRich Syn 3 GRich Syn 4

R Boom 2 GRichFX GRich Syn 1

Pad: A12: HipHo.GRichSyn1 *

Type: Tune v

GRichKick 2 GRichPere GRichshk

GRichKick GRich Snr 1 GRichHat 1 GRichHat 2
GRich Snr 2

Original ped :  Pad 4 -

Once we press the Close button, the same sound will be loaded in all the pads but in a
chromatic way, starting from the lower left the lowest and ending at the upper right the
highest. In this way, and as long as we keep the "16 LEVEL" option checked (indicated
with yellow color), no matter which pad we press, the sound we have chosen will be
played, but in a different key. Now, playing the pads, we will be able to generate the
melody or bass line we wanted. Here it is ideal if you have a keyboard, because it will be
easier to generate melodies.
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If we want to reload the default kit, we uncheck the "16 LEVEL" option, and we will have
again the variety of different sounds loaded with the program kit.

This can be done with any of the sounds in the kit.

ASSING AN INSTRUMENT TO A TRACK

We can use one of the instruments that come with

some of the expansions. The first thing fo do is to set the _

tfrack type as "keygroup".

Once this is done, we can choose an instrument
from the expansion browser "Expansion Browser".
In our case, in the free package, we have the
expansion "F? Instruments Beats Edition", loaded
with a multitude of good sounds. Here we will
choose the sound we want, and by double

clicking, it will be loaded on the track. MPC

All you have to do is select "Program” in the track EEATSEDTION
inspector. F9 INSTRUME

Wk,

1 Piano

m

Program 002

Inst-Piano-F9 Club Plana

MPC Beats Demos and Templates

MPC Beats Producer Kits

© 2 ®

ASSIGNING A PLUGIN TO A TRACK

It is also possible to select a plugin from those included in MPC _
Beats.
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To do this, select the third optfion "Plugins" in the track

W

1 Piano inspector.
o You will see that the TubeSynth plugin is automatically
- selected.
Plugin 001
TubeSynth If we expand the list of plugins, we can see that we have
> | Defaul three different plugins provided in the free MPC Beats
pack:
) TubeSync: TubeSynth emulates the sound of classic

analog polysynthesizers with five integrated AIR effects. The instrument has
been created by AIR and is based on the same advanced analog modeling
technology found in their acclaimed Vacuum Pro desktop synthesizer.

TubeSynth comes with a complete factory library of over 300 state-of-the-art
patches including synths, leads, pads, basses, organs, and effects presets.

e Bassline: AIR Bassline emulates the sound of classic mono synthesizers with a
contemporary twist. It also includes four built-in AIR effects, as well as two built-
in distortion algorithm:s.

In addition to its flexible oscillator with continuously variable waveforms (with
octave saw, saw, square and sine waveforms), more than 150 patches are
available.

e Electric: Emulates the sound of classic electric pianos with extensive flexibility
in sefting the fimbre of the electric piano. Includes 5 effects (Tremolo, Valve
Distortion, Chorus, Delay, and Spring Reverb) and includes over 80 preset
sounds.

~

1 Sequence 01

2

| i

BE MPC Plugins
~ Bassline
1 Piano Electric
TubeSynth
L 3

~

Plugin 001

TubeSynth
+ Default

Kontakt 5
Kontakt 5
Kontakt 5
MODO BASS
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Once you have selected the plugin, you can e ’“uw‘d

navigate between the presets directly by selecting - —

it below where you have selected the plugin. By & Synth Hors

playing the on-screen pads or the piano keyboard, ISR Hallofron

you can hear the sounds triggered by the selected [ :::1"

preset until you find the sound you are satisfied with. ¥ Default Soft Perc Chords

Synth Stutter Chords

To access the plugin configuration, right next - Z”Ph‘“”"

to the plugin name, we have a button that will Pad Smooth Meta

open this one where we will be able to modify Bz s
different parameters provided by the plugin. e e tny

FX Noisey Sweep

Init Super Fuzz

ASSIGNING A VST PLUGIN TO A TRACK

If you have a VST instrument installed on your computer, you can also use it as an
instrument within MPC Beats in the same way as other instruments.

As we have done to assign an MPC Beats plugin, we will select
the third option "Plugins” in the frack inspector.

w

1 Sequence 01

. Once here, when displaying
[ o i the list of plugins, all the VST

B MPC Pluging

@ BT insfruments that we have
1 Piano Electric

=  Tubesyntn installed should appear.

.

Plugin 001 Pt Just click on the one you

Ample Bass P Lite Il

TubeSynth Ample Guitar M 1 want to load it in MPC Beats.

+ Default EZdrummer
EZkeys

Al Once you have selected the

Eb?&g plugin, you can navigate
Kontakt 5 between the different
O presets just below where you
have selected the plugin. By
playing the on-screen pads
or the piano keyboard, we
can  hear the sounds

friggered by the chosen preset until we find the sound we are satisfied with.

Wi To access the graphical interface of the VST plugin, right next to its name, we have
a button that will open this one, where we will be able to manage and configure
our plugin to our liking.
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1 Sequence 01

2
-
1 Track 01

-  ELECTRONIC & POP.
+ HPHOP

#JAZZ

Plugin 001 #ROCK

o ; +SOUL & FUNK
SkString Sectio  £2

$ CiProkewalk

!
Plugin 001

WHERE ARE MY VST INSTRUMENTS

If you don't find the VST instruments installed on your computer when you display the
plugins list, you will probably have to tell MPC Beats the path where they are installed. If

you know this path, do the following:

In the menu, go to Edit > Preferences...

File »
In the "Preferences" screen, go to the Plugins tab. m.s.
Here, locate the path where your VST plugins are HI‘;
located with the "..." button, and once located i

~

1 Piano
Preferences

-

([ d:\VSTPlugins Pl Ugil'l ol

Plugins

Sequencer

Rescan All Scan New

Undo

Undo Histary.

Cut
Copy

Time Correct
Humanize...

Pitch Quantize. .

Audio Region

Seguence
Track

Program

Preferences

and selected, check the red
checkbox as shown
screenshot below.

in the

Once selected, by clicking the
Scan New button, it will read
the plugins one by one and
add them to MPC Beats. Once
the process is finished, we will
be able to use them to create
our Beats.

10



RECORDING A BEAT WITH MPC BEATS @&mnﬂ

ADDING A SOUND EFFECT

If we want to add a sound effect, or an audio plug-in such as an equalizer, compressor,
or any other, we can do it easily from the Channel Mixer view "Chanel Mixer".

To select the Chanel Mixer, we can do it from the side

transport bar by clicking on the corresponding icon:

This will open the Chanel Mixer view, where we will be able
to mix our song. In this mixer, we will have identified the following groups: MIDI TRACKS,
AUDIO TRACKS, PROGRAMS, SUBMIXES, RETURNS and MASTERS.

We will be able to add an effect or plugin to any of them.

Input 1,2

Out1,2

To add an effect in any of the
inspectors, we find at the top the
INSERTS section.

We will see that there are four
boxes waiting for a plugin or
effect that we choose. By simply
unfolding the list, we will be able
to visualize a list with all the plugins
that we have properly organized

and where we will choose the o1z
desired one according fo our
needs.

11
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Once selected, just click on the name to modify its different characteristics.

- In the same way, we can add our favorite VST
< it pluglﬂs

Threshold

Ratio

Knea

Attack
Release
Output
Mix

T Uefuuk Selling

c‘ f'nbfiller Pro-C’

12
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